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1. OVERVIEW 

The 7780TSM line of remote probes is a complete embedded hardware based solution for compressed 
network monitoring. By monitoring the MPEG Transport Stream at strategic points within the distribution 
network, in conjunction with the industry leading VistaLINK® PRO NMS (Network Management System), 
the 7780TSM offers service providers the tools to continuously and effectively have the confidence that 
their MPEG-2/H.264 signals within any IPTV, Satellite, terrestrial or cable network is being delivered 
properly. 
 
The 7780TSM supports the two most popular interfaces ASI or IP. With support for over 400Mb/s (on 
ASI), 200Mb/s (on IP) of total MPEG-2/H.264 traffic on a single 7780TSM, these probes can, for 
example, separate encoder errors from network delivery errors allowing the operator to act quickly and 
avoid down time. 
 
The industry leading Evertz VistaLINK® PRO NMS offers a new dimension to TS monitoring by allowing 
a graphical customization of any measurement performed and a quick viewing of the different points in 
the system. It makes the 7780TSM probe system a valuable system in any operational environment. 
 
Features 

• 2 ASI inputs  
• Transport Stream analysis: 

o Presence, Bitrate analysis, table rate analysis 
o TR101290 Level 1, level 2*, and partial level 3 

• Complete TS and PID bitrate measurement from 100kb/s to 200Mb/s with settable limits 
• Display of Transport Stream tree 
• Display of video resolution, audio type, etc. 
• Matching of PID assignment with pre-define PID list and TSID verification 
• Only PCR accuracy and PCR repetition rate supported at this time. No jitter measurement 
• Up to 5 hot-swappable 7780TSM modules per chassis 
• Fully Integrated with the Industry leading Evertz VistaLINK®  PRO NMS 
• Auto-Response Scripting Capability 
• Comparing of same stream at different location in network 
• SNMP Enabled (control and alarms for monitoring) 
• Complete customization of status view and error report in VistaLINK®  PRO 
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Figure 1-1: 7780TSM-ASI Block Diagram 

 

2. INSTALLATION OF 7780TSM-ASI 

2.1. HARDWARE INSTALLATION 

Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn. 
 
Unpack the 7780TSM-ASI and separate the rear card from the main card.  Locate on the rear of the 
rack, two adjacent vacant slots. Insert the rear card into the back of the chassis and secure using four 
of the screws provided.  
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Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the 7780TSM-ASI card into the corresponding front slots ensuring the card lines up with the 
slot runners on the bottom and the top of the chassis. Push the card into the slot ensuring that when it 
mates with the rear card that is has been firmly pushed into a seated position. This can be confirmed 
when the connectivity lights for the Ethernet port are illuminated. Do not connect any cables to the rear 
card (failure to do this could cause unwanted network issues) until the initial configuration has been 
completed. 
 

 
 
Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration: 
 

 
Figure 2-1: COM Properties Window 

 
Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 
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Click OK to apply these settings and press return. The session should respond with the TSM-ASI Main 
Menu as shown in Figure 2-2:  
 

 
Figure 2-2: HyperTerminal Main Menu 

 
(1) Network Configuration 
This sub-menu enables the user to configure the network settings for the card. 
 
(2) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community 
strings. 
 
(3) Setup Transport Stream Receivers 
This sub-menu is used to configure the Transport Stream Receivers. As this configuration can also be 
performed via VLPro this sub-menu will not be covered in this section. 
 
(4) Utilities 
This sub-menu contains two utilities. One command is for clearing the memory, and the other for 
clearing the flash. In normal operation it should not be necessary to use either of these options. 
 
(5) Engineering/Debug 
This menu is for Evertz personnel only. You may be requested to access and execute options within 
this menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic 
network settings via the serial cable, this is covered in the next section. 
 

2.2. CONFIGURING THE BASIC NETWORK SETTINGS 

From the main menu, select option (1), for Network Configuration and press return. The Network 
Configuration sub-menu will appear as shown in Figure 2-3: 
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Figure 2-3: Network Configuration Sub-Menu 

 
1. Select option (1) Set IP Address and configure the IP address for the 7780R2X1-CS-2 ensuring 

that the IP address is not already in use on the network.  
2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.  
3. If required also configure option (3) Set Gateway.  
4. Exit from the Network Configuration menu using (S) Save and Exit NOT (X) Exit. 

From the Main Menu select option (2) SNMP Configuration. Normally it is only necessary to configure 
here, under option (1) Set Trap IP Address, the IP address of your VLPro Server.  Exit using option (S) 
Save and Exit.  Now extract the card from the rack and re-insert it. 
 
Remove the front card, detach the serial cable and re-insert the card firmly back into the chassis slot.  
You have now completed the necessary minimum configuration and can connect the cables to the rear 
card when ready. 
 

2.3. CONNECTING TO VLPRO 

This chapter assumes that VLPro server and VLPro client are already configured for your network and 
you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 7780TSM-ASI jar file to the server and both the client and server 
applications have been restarted. If you are the network administrator refer to the section 5.2 for 
information on Updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+”. Your 
7780TSM-ASI should appear as a newly listed device with the IP address used to configure the card 
earlier. It may take up to a minute to appear while the card and switch negotiate network settings (this 
can be verified directly on the switch if necessary.  
 
NOTE: If after a couple of minutes the card has still not appeared try selecting Add Agent from the 
Tree> Add/Update Agent menu. Enter the IP address used in the configuration stage earlier and select 
OK.  The card should now be listed and will remain greyed out for a moment while VLPro finds the card 
and confirms its configuration.  
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Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
 

 
Figure 2-4: VistaLINK® PRO Hardware Configuration 
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3. CARD CONFIGURATION 

3.1. INPUT STATISTICS 

Right-click the IP address of the 7780TSM-ASI sub-menu. Select View Configuration. The right window 
will display the 7780TSM-ASI Configuration menu as shown in Figure 3-1. 
 

 
Figure 3-1: VistaLINK® PRO Input Status Tab 

 
The Input Status page will open in the right window of VLPro.  Here we can confirm that the correct 
board has been selected from the tree and that the board is loaded with the correct firmware in the 
Card Type box. Below that is the status of the two inputs. The status of the inputs will not change 
unless a valid ASI feed is connected to the rear plate of the card and the status is refreshed using the 
refresh button located at the top of the configuration window. Using the continuous refresh button can 
aid troubleshooting connectivity issues although will prevent any configuration changes. 
 
There are no user configurable items on this page, it is for information only. 
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3.2. NETWORK STATISTICS 

The Network Statistics tab displays the network statistics for the two individual gigabit Ethernet 
interfaces on the back plate. The upper port, as viewed from the back of the chassis, is the 
Management Port (Control) and the other is the data port. The data port, in the context of the TSM-ASI, 
is not used and does not require any configuration or connection. 

 

 
Figure 3-2: VistaLINK® PRO Network Statistics Tab 

 
The network statistics can be reset at any time by selecting the “Clear Network Stats” drop down box, 
as shown below, and selecting the “Clear” option. Once the setting is applied, using the apply button, 
the statistics will be reset and begin to count from zero again. 
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4. CONFIGURING INPUTS 

With the TSM-ASI hardware tree expanded, it is possible to see the sub components, in this case Input 
1 and Input 2. By right clicking and selecting configure it is possible to configure each of the inputs fully 
independently of each other. The section below outlines the use and meaning of each of the tabs and 
any user configurable entries. 
 

4.1. BITRATE VIEW TAB 

The Bitrate View tab is where VLPro displays the standard Transport Stream parameters. As shown 
below it is possible to see all the packets within the TS stream. They are organized in ascending order 
by Service ID.  It is possible to reverse the ordering or select another column to re-sort the data. This 
can be done by double clicking the column header, make sure you are not in the auto refresh mode 
when doing this. 
 
For each individual PID it is possible to view the minimum and maximum Bitrate since the last reset. By 
configuring the minimum and maximum threshold it is possible to configure the desired thresholds for 
notifying the user through VLPro. The Bitrate View is a dynamic view; by clicking the auto refresh it is 
possible to see near instantaneous values for the stream. 
 

 
Figure 4-1: VistaLINK® PRO Bitrate View Tab 
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4.2. INPUT CONFIGURATION TAB 

This tab is used to select the stream type being monitored and input basic configuration information for 
the stream. The additional information is used to further enhance the transport stream diagnostics and 
alarming capabilities of the card. 
 

 
Figure 4-2: VistaLINK® PRO Input Configuration Tab 

 

4.2.1. Input Parameters 

• Input Name: Where the stream can be given an easily identifiable name.  
  
• Input Mode: Options available are ATSC, DVB and MPEG.  

o It is important to select the standard to which the stream is being coded as this affects 
the context of the alarms for ETSI TR 101 290 priority 3. 

 
• Transport Stream ID expected: Enter the value for the Transport Stream ID expected, enter 

zero to disable the test. 
 
• Number of PIDs expected:  Enter here the number of PIDs expected in the stream (including 

the null packets if any), enter zero to disable the test. 
 
• Set PID List: Enter here the list of PIDs found within the stream. 
 
• PID Display Mode: Options available are Decimal or Hex.  
 
• TS ID Display Mode: Options available are Decimal or Hex  
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Note: It is not possible to enter the TS ID as a Hex value. 

 
 
• Min Bitrate: Enter a decimal value corresponding to the absolute lowest bitrate expected; an 

alarm condition will be caused if the stream rate should drop below this value. 
 
• Max Bitrate: Enter a decimal value corresponding to the highest bitrate expected; an alarm 

condition will be caused if the stream rate should exceed this value. 
 

4.2.2. Misc Control Entry 

• Clear Monitoring: Selecting the clear option and applying it will clear the recorded statistics for 
the Max and Min bitrates as well as reset the error counts for all Priority 1, 2 and 3 Syntax 
Errors. 

 

4.2.3. Input Control 

• Monitor Enable: Using this drop-down box it is possible to enable or disable individual inputs 
to stop alarm generation. This stops all alarms from the 7780-TSM being sent to the VLPro 
Server. 

 

4.3. INPUT MONITOR TAB 

The Input Monitor Tab provides the user with an overview of the input status. 
 

  
Figure 4-3: VistaLINK® PRO Input Monitor Tab 
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4.3.1.  Input Monitor 

• Input State: Either active or inactive. 
 
• Num Programs: This is the number of programs found in the input stream. 
 
• Num PIDS: This is the total number of individual PIDs found in the stream. 

o Includes all ghost PIDs and Null packets. 
 

• Input Bitrate: This is the current bitrate of the input ASI stream. 
 
• Transport Stream ID: The decimal value for the input stream. 

o For example: Corresponds to one satellite transponder. 
 

• Network ID: The decimal value for Transport Stream Network ID. 
o For example: Corresponds to one entire satellite of transponders. 
 

• Network Name: If available the network name will be displayed. 
 

4.3.2. Error Monitor 

• Input Status: A system message to notify the user if the input is valid ASI. 
 
• Syntax Error Status: A system message to notify the user if any of the ETSI TR 101 290 

P1/P2/P3 monitoring tests are currently in an alarm condition. 
 
• Template Error Status: A system message to notify the user if the TS input does not comply 

with the template parameters entered in the Input Configuration Window. 
 

4.4. TS SYNTAX ERRORS – P1 & P2 

This tab displays a general health check of the most important elements of the TS. The tests are not 
exhaustive and are outlined in detail in the document Digital Video Broadcasting (DVB); Measurement 
guidelines for DVB systems ETSI TR 101 290. It should be noted that the P3 errors are content 
sensitive to the type of input stream selected. 
 



7700 MultiFrame Manual 
7780TSM-ASI Transport Stream Monitor 

 

Configuring Inputs Revision 1.0 Page 13 

 
Figure 4-4: VistaLINK® PRO TS Syntax Errors – P1 & P2 Tab 

 

4.4.1. P1 Necessary for Decoding 

• TS_sync_loss:  The most important function for the evaluation of data from the MPEG-2 TS is 
the sync acquisition. The actual synchronization of the TS depends on the number of correct 
sync bytes necessary for the device to synchronize; two or more consecutive corrupted sync 
bytes indicate sync loss. After synchronization has been achieved the evaluation of the other 
parameters is carried out. 

 
• Sync_byte_error:  The indicator "Sync_byte_error" is set as soon as the correct sync byte 

(0x47) does not appear after 188 or 204 bytes. This is fundamental because this structure is 
used throughout the channel encoder and decoder chains for synchronization. It is also 
important that every sync byte is checked for correctness since encoders do not necessarily 
check the sync byte.   

 
• PAT_error: The Program Association Table (PAT), which only appears in PID 0x0000 packets, 

tells the decoder what programs are in the TS and points to the Program Map Tables (PMT) 
which in turn point to the component video, audio and data streams that make up the program. 
If the PAT is missing then the decoder can do nothing, no program is decodable. Nothing other 
than a PAT should be contained in a PID 0x0000. 

 
• Continuity_count_error:  For this indicator three checks are combined. The preconditions 

"Incorrect packet order" and "Lost packet" could cause problems for receivers that are not 
equipped with additional buffer storage and intelligence. It is not necessary for the test 
equipment to distinguish between these two preconditions as they are logically OR-ed, together 
with the third precondition, "a packet occurs more than twice" into one indicator.  
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• PMT_error: The Program Association Table (PAT) tells the decoder how many programs there 
are in the stream and points to the PMTs that contain the information where the parts for any 
given event can be found. Parts in this context are the video stream (normally one) and the 
audio streams and the data stream (e.g. Teletext). Without a PMT the corresponding program is 
not decodable. 

 
• PID_error:  It is checked whether there exists a data stream for each PID that occur. This error 

often occurs where TS are multiplexed, or demultiplexed and again remultiplexed.  
 

4.4.2. P2 Recommended 

• Transport_error:  The primary Transport_error indicator is Boolean which counts the erroneous 
TS packets. This counter is intended for statistical evaluation of the errors. If an error occurs, no 
further error indication should be derived from the erroneous packet.  

 
• CRC_error:  The CRC check for the CAT, PAT, PMT, NIT, EIT, BAT, SDT and TOT indicates 

whether the content of the corresponding table is corrupted. In this case no further error 
indication should be derived from the content of the corresponding table. 

 
• PCR_error:  The PCRs are used to re-generate the local 27 MHz system clock. If the PCR 

does not arrive with sufficient regularity then this clock may jitter or drift. PCR discontinuity of 
more than 100 ms occurring without specific indication or the time interval between two 
consecutive PCR values is more than 40 ms. 

 
• PCR_repetition_error: The PCRs are used to re-generate the local 27 MHz system clock. If 

the PCR do not arrive with sufficient regularity then this clock may jitter or drift. The 
receiver/decoder may even go out of lock. This error indicates that the time interval between two 
consecutive PCR values is more than 40 ms. 

 
• PCR_discontinuity_indicator_error: The PCR_discontinuity_indicator_error is set in the case 

that a discontinuity of the PCR values occurs that has not been signalled appropriately by the 
discontinuity indicator.  

 
• PCR_accuracy_error: The accuracy of ±500 ns is intended to be sufficient for the colour 

subcarrier to be synthesized from the system clock. This test should only be performed on a 
constant bitrate TS as defined in ISO/IEC 13818-1. 

 
• PTS_error: The Presentation Time Stamps (PTS) should occur at least every 700 ms. The PTS 

is only accessible if the TS is not scrambled. 
 
• CAT_error:  The CAT is the pointer to enable the receiver to find the EMMs associated with the 

CA system(s) that it uses. If the CAT is not present, the receiver is not able to receive 
management messages. 
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4.5. TS SYNTAX ERRORS - P3 

 
Figure 4-5: VistaLINK® PRO TS Syntax Errors - P3 

 

4.5.1. P3 DVB Tables 

• NIT_Repetition_error: This test checks that any two sections with table_id = 0x40 (NIT_actual) 
occur on PID 0x0010 within a 25 ms. 

 
• NIT_error: Network Information Tables (NITs) as defined by DVB contain information on 

frequency, code rates, modulation, and polarization etc. of various programs that the decoder 
can use. It is checked whether NITs are present in the TS and whether they have the correct 
PID. The test checks that sections with table_id 0x40 or 0x41 in PID value 0x0010 occur at least 
every 10 s. 

 
• Unreferenced_PID: Each non-private program data stream should have its PID listed in the 

PMTs. This test detects the presence of a PID (other than PAT, CAT, CAT_PIDs, PMT_PIDs, 
NIT_PID, SDT_PID, TDT_PID, EIT_PID, RST_PID, reserved_for_future_use PIDs, or PIDs user 
defined as private data streams) not referred to by a PMT within 0.5 s 

 
• SI_repetition_error: For SI tables a maximum and minimum periodicity are specified in EN 300 

468 [7] and TR 101 211 [8]. This indicator should be set in addition to other indicators of 
repetition errors for specific tables. 

 
• SDT_error:  The SDT describes the services available to the viewer. It is split into sub-tables 

containing details of the contents of the current TS (mandatory) and other TS (optional). Without 
the SDT, the IRD is unable to give the viewer a list of what services are available. It is also 
possible to transmit a BAT on the same PID, which groups services into "bouquets". 
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• SDT_Repetition_error: This test checks that the SDT information which describes the services 
contained in a particular Transport Stream is transmitted at least every 2 seconds on PID 
0x0011. 

 
• EIT_error:  The EIT (Event Information Table) describes what is on now and next on each 

service, and optionally details the complete programming schedule. The EIT is divided into 
several sub-tables, with only the "present and following" information for the current TS being 
mandatory. The EIT schedule information is only accessible if the TS is not scrambled. 

 
• RST_Repetition_error:  This test checks that any two sections with table_id = 0x71 (RST) 

occur on PID 0x0013 within 25 ms (or lower). 
 

• RST_error: The RST is a quick updating mechanism for the status information carried in the 
EIT. 

 
• TDT_Repetition_error: This test checks that any two sections with table_id = 0x70 (TDT) occur 

on PID 0x0014 within 25 ms. 
 

• TDT_error: Sections with table_id = 0x70 (TDT) not present on PID 0x0014 for more than 30 s. 
The TDT carries the current UTC time and date information.  

 
More information can be found at: http://www.etsi.org/ 
 

4.5.2. P3 ATSC Tables 

• MGT Repetition: Master Guide Table. For each type of PSIP tables, the MGT provides the 
location in the Transport stream, the current version of the table and the length in bytes. This 
test checks that the Master Guide Table repetition rates do not exceed 150ms. 

 
• TVCT Repetition: Terrestrial Virtual Channel Table. Consists of virtual channel definitions 

where each channel is characterized by the two-part channel number that the user will use to 
access the service, its text name, how the service is physically delivered, its MPEG-2 
program_number, its “source ID” and the type of service. This test checks that the Terrestrial 
Virtual Channel Table repetition rates do not exceed 400ms. 

 
• CVCT Repetition: Cable Virtual Channel Table. Consists of virtual channel definitions where 

each channel is characterized by the two-part channel number that the user will use to access 
the service, its text name, how the service is physically delivered, its MPEG-2 program_number, 
its “source ID” and the type of service. This test checks that the Cable Virtual Channel Table 
repetition rates do not exceed 400ms. 

 
• EIT Repetition: The PSIP table that carries program schedule information for each virtual 

channel, this test checks the following is true: 
o EIT-0 Once every 0.5 seconds 
o EIT-1 Once every three seconds 
o EIT-2 and EIT-3 Once every minute 

 
• RRT Repetition: Rating Region Table. Defines a rating system for a given region characterized 

by a number of rating dimensions, each of which is composed of two or more rating levels. This 
test checks that the Rating Region Table repetition rates do not exceed 60,000ms. 
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• STT Repetition: System Time Table. Provides a reference for the time-of-day to receivers. This 
test checks that the System Time Table repetition rates do not exceed 1000ms  

 
More information can be found at: http://www.atsc.org 
 

4.5.3. ETSI TR 101 290 Test Conditions 
The status LED located to the left of each test will highlight, when in Auto-Refresh, the dynamic status 
of the stream. 
 
For many of the ETSI TR 101 290 test it is possible to configure custom configurations to ensure that 
particular alarms and conditions are fed back to the operator. It is important to select the Monitor 
Enable check box (to enable custom monitoring parameters to be invoked), select the desired alarm 
Severity and then configure the test Threshold.  
 

 
NOTE: For Syntax Errors P1, P2 & P3, PCR Accuracy Errors are measured in ns. 
All other Threshold errors are measured in ms. 

 

4.6. FAULT CONTROL 

The fault control tab is a user configurable tab for enabling or disabling the fault conditions that can be 
triggered by the standard ETSI TR 101 290 checks discussed in the previous chapter. 

 

 
Figure 4-6: VistaLINK® PRO Fault Control Tab 

 
The four window sub-sections allows users to custom configure which ETSI TR 101 290 test conditions 
can trigger an alarm: 
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Within this tab it is possible to individually de-select (all are selected by default) or re-select which tests 
can produce an alarm condition. The following subsections correspond with the previous two tabs: 

• P1 Necessary for Decoding 
• P2 Recommended 
• P3 DVB Tables 
• P3 ATSC Tables 

 
It is important to ensure new settings are applied using the apply button on the menu. 
 

 

DVB/ATSC tests may be greyed out depending on which mode has been selected 
under the Input Configuration Tab (DVB/ATSC or MPEG). ATSC mode will disable 
DVB; DVB mode will disable ATSC and MPEG will disable both ATSC and DVB. 

 

4.7. TRIGGER FAULTS TAB 

The Trigger Control tab provides a user configurable custom configuration for the top-level alarm 
statuses. This can be used to provide quick visual overviews of the ETSI TR 101 290 test status. An 
operator would need to refer either to the TS Syntax Error Tabs and review the status LED’s, or to the 
alarm log to identify the test condition(s), which have triggered the alarm (status red). 
 

 
Figure 4-7: VistaLINK® PRO Trigger Faults Tab 

 
The two window subsections, Trigger Fault Enable and Trigger Fault Status, permits the user to 
customize the top-level alarms. By de-selecting, all levels are checked by default.   
 
In the third window subsection there is a single fault called Ts Bitrate Enable. This relates to the second 
Tab (Input Configuration) and provides a summary alarm for the status of the maximum and minimum 
bitrates that were configured. No alarm would therefore imply that all PIDs are within the configured 
bandwidth limits defined by the user.  
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5. TROUBLESHOOTING 

5.1. VLPRO DOES NOT DISPLAY THE 7780TSM-ASI ALARMS 

Refer to section 1 to connect directly to the board via the serial port. Once a connection has been 
establish check and/or configure the SNMP settings with the correct VLPro Server IP address and 
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as 
to what these should be set to. 

 

5.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared even 
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 5-1: VistaLINK® PRO Server  

 
A window will appear, as shown below, simply navigate to the location of the new JAR file and select 
the file by double clicking. The window will automatically close and the update will be applied in the 
background.  
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Figure 5-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
 

Now shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, 
it is normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied.
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6. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  BandWidth 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 

[9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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